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Summary: A critical path is defined as the longest duration of a set series of activities to a major 
event will produce the critical path.  The OPDEC Critical Path tool is an add-on to Microsoft Project 
that displays a graphic representation of up to 5 critical paths and their associated integration 
points. It provides a quick analysis of the critical paths to major events in the Integrated Master 
Schedule (IMS).   

 

Example: (Critical Paths 1-5 to Selloff Unit 5”), displays the top 5 critical paths to the event. The 
legend, (Path 1, Path 2, etc.), shows the float (slack) for each path. The user is now equipped with 
the required reference points to enable quick analysis of the IMS mapping network.  
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Path 1
-83 days

Path 2
-57 days

Path 3
-50 days

Path 4
-50 days

Path 5
-50 days

Progress Risk

8/19/06

Selloff Unit 5
 Critical Paths 1-5 to Milestone

(Sub A)  Weldment MTA
(Sub A) Assembly/ATP MTA

(Sub A) Final Out and Ship MTA
(Sub B) MTA Valve Inspection

(Sub B) Customize and Test Seal

(Sub B)  Integration
(Sub B) Packout and Prep Logbook

(Sub B) Ship to Prime
(Sub B) Delivery at Prime

Receive from Sub B
Assemble and Test Unit 5
Assemble and Test Unit 5 Third Stage

Third Stage Element Unit 5 Delivered
Assemble and Test Unit 5 Upper Stage Assembly

Upper Stage Assembly Unit 5 Delivered
Assemble and Test Unit 5

Selloff Unit 5

2/13
Receive Regulator Assembly

Guidance Material Complete

Assemble and Test Unit 5 Guidance Section 
Guidance Section Unit 5 Delivered

(Sub C) DropTest
(Sub C) Environmental Test

(Sub C)  ATP Test
(Sub C) Inspection & Close

(Sub C) Accumulate, Package & Ship
(Sub C) Conduct HAR

(Sub C) Kit 8-5 Shipped To Prime
Kit Unit 5 Received by Sub C

(Sub C) ITP Test
(Sub C) AE Environments

(Sub C) GU Environmental Test
(Sub C) Acceptance Test
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Minimum Software Requirements:  
• Milestones Professional 2008 (www.kidasa.com) 

• Microsoft Project 2010  

• Microsoft Windows 7 
 

Installation and Activation 
 
Installation 

1) Download the installation file from www.opdec.com/ms-project-tools/critical-path-tool 
2) Run the file to begin setup 
3) Follow the on-screen prompts indicating installation location and the end user license 

agreement 
 
Activation 

1) Open Microsoft Project 
2) Navigate to the “OPDEC” ribbon and click the “Critical Path 2020” button in the “2020 Base 

Tools” group. 
  

http://www.opdec.com/ms-project-tools/critical-path-tool
http://www.kidasa.com/Download/index.html
http://www.kidasa.com
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3) Upon first launch, you will be presented with the activation window. The activation process 
can be delayed for up to 30 days using the “Activate Later” button. 
 

 
 

4) If you have an internet connection 
on your PC, click “Activate Now” 

a. Fill in your name, email, 
company, and assigned 
serial number provided 
upon purchase of the 
software. It is an 8-digit, 
alphanumeric code 
separated by a dash (e.g. 
a1b2-c3d4). 
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b. Click “OK” and your activation will be complete. Note that sometimes internet 
security measures will prevent the online activation. Please see #5 below. 
 

5) If you do not have an internet connection, click “Obtain via Telephone or Email” in “Step 2: 
Offline Activation” 

a. A popup will appear displaying your PC’s unique identifier. 
 

 
 

b. You will need to provide this to OPDEC Support along with your serial number in 
order to receive an activation key. You can email us at support@opdec.com using the 
“Send Email” button, or call us at (256) 881-1038. 
 
 
 

 
 
 
  

mailto:support@opdec.com
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Milestones Professional Setup 
 
The options below help configure Milestones Professional to operate correctly when used in 
conjunction with the Critical Path tool.  
 

1. Open Milestones Professional 
2. Navigate to the “Tools” ribbon, and select the “Files and Automation” button in the  

“Program Options” subgroup. 
 

 
 

3. Check the “Run as Multiple Instances for COM Automation” as seen below. Setting this 
option will require administrator privileges on your PC. Enabling this setting helps resolve 
Common Error #4. 
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4. Click the “Run ReReg.exe to recreate Milestones Com and file association registry entries.” 
button. This button runs a process that recreates the registry keys needed for the application 
to run correctly. These help the Critical Path tool detect that Milestones Professional is 
installed on the device and helps the Critical Path tool automate Milestones Professional. 
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Configuring the Critical Path Settings 
 
To begin using the tool, the first step is to configure the required settings, and to create a 
settings profile. After the tool is launched, click on the “Tools” menu option, and then select 
“Settings”. 
 

 
 
These settings will identify key information within your schedule that the tool needs in order to 
perform its calculations. Multiple settings profiles may be created by the user in order to quickly 
change the tool’s settings to work with multiple schedules. On first launch, the “Default Profile” 
will be selected. 
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Settings Profile 

 
At the top of the settings form, you will see the “Settings 
Profile” option. To fill this list with multiple settings 
profiles (for use with multiple schedules), you can use the 
“Profile” menu option and its available actions to create a 
new profile as well as rename, save, or delete the 
currently selected profile. 
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Required Settings 
 

 
 

• Milestone Template Location 
o This setting should identify the directory containing your Milestones Professional 

templates used by the tool. These are installed to the location provided during 
installation in the “Templates” folder as seen in the image above. 

 

• Result Save Location 
o This setting identifies where the tool will save the files it produces. 
 

• Empty Text Field 
o This setting should target a custom text field within Microsoft Project that the tool can 

utilize. The tool will store path identification data in this field, and will clear the contents 
of this field repeatedly during processing. 

 

• Major Event Field 
o This setting should target a custom text or number field within Project that identifies the 

Major Event tasks (aka Milestones) of the schedule. The identification is made by the user 
entering a unique value in the field. This is the most complicated setting to understand. 
Major Event tasks are often (but not always) 0-day duration tasks that mark significant 
progress in a schedule. These are the tasks that a user will typically be running critical 
paths to. Every task marked as a Major Event will have any constraints or deadlines 
removed during the tool’s calculations. This is done to assess the critical path based 
purely upon duration and slack, disregarding tasks artificially held at a point in time. If the 
user wants to honor a constraint or deadline in their critical path chart, they can leave 
the Major Event field blank (if Text) or equal to 0 (if Number). 
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• Target Date Field 
o This setting specifies the date the targeted task (that the critical path is being run to) 

must be complete by. If you are unsure, the “Baseline Finish” field is a good starting 
point. However, all date fields within Project are available as options, since many users 
prefer their end dates to be customized. Alternatively, the user may manually enter their 
own custom date by selecting “User Defined Date”. Selecting this option will result in a 
textbox appearing that allows the manual entry. 

 

• Progress Method 
o This setting is used to determine how progress will be displayed on the chart. A task’s 

duration will be filled, partially or completely, with a black bar indicating the amount of 
progress made on the task. Available options are the built-in Project fields “% Complete”, 
“Physical % Complete”, and “Status Date”; alternatively, the user may utilize custom 
Number fields to indicate a percentage of progress (e.g. “CAM % Complete”). 

 
Optional Settings 
 

 
• Contract Date Field 

o This setting is used to display a contract date on the resulting Critical Path chart. The 
value given in the date field specified will be used as the contract date. A symbol (circled 
blue diamond) will be drawn on the chart on the same row as the targeted task’s finish 
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date, and a crisscrossing dotted red line will be drawn from the contract date symbol to 
the target finish date. This is to illustrate and emphasize whether the task’s estimated 
finish date will be before or after the contract date. 
 

• Contract Date Display Text 
o If you would like the contract date to be displayed with some identifying text (e.g. “Final 

Completion Date”), you may enter that custom text here. Whatever value you enter will 
be shown to the left of the contract date symbol. This setting is only utilized if the user 
also specifies a Contract Date Field. 
 

• Prepend Value Onto Activity 
o By default, the tool will display the Task Name to the left of each task bar shown along a 

critical path. If you would like to display additional information, you can specify that here. 
Common values for this setting are ID or Unique ID, allowing the chart’s viewer to not 
only see which tasks are contained within a critical path, but also the corresponding ID 
used in the Project file. This data will be displayed within parentheses, and will precede 
the task name. 
 

• Append Value Onto Activity 
o While the task name and Prepend Value are shown to the left of a task, you can also 

specify information to be displayed to the right of a task. To append additional data from 
a custom text field, you can specify those values here. 
 

• Title of Appended Value 
o Only works in conjunction with the “Append Value onto Activity” setting. Whatever text 

you enter here will be displayed before the value specified in the “Append Value” setting. 
 

• Default Number of Paths 
o This option allows the user to specify a default value for the “Paths” option on the main 

form. 
 

• Default Lines per Page 
o This setting allows the user to specify the number of rows contained on one page of the 

resulting Milestones Professional chart. Increasing the number of rows will allow room 
for compressed charts, but may cause the chart to flow onto multiple pages of 
Milestones Professional. By default, the tool will force the entire chart to be displayed on 
one page. 
 

• Use Major Event Field as Filename 
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o The filenames of charts produced by the tool will be automatically named “[Unique ID] 
Master”. To change this to instead include the value contained within the Major Event 
field (identified in the Required Settings), you may check this box. 
 

• Always Show Event as Milestone 
o The target event by default will always be shown as a milestone (a diamond symbol with 

no duration). If your targeted task has duration and you wish that to be represented in 
the result, you may uncheck this box to show it as a normal task, displayed as a bar 
instead of a diamond representing a single point in time. 
 

• Display Master Descriptions Page 
o To create a text result along with your visual critical path chart, check this box. An 

additional file will be generated along with every critical path that details the chart in 
text form. This is a higher level detail than the “Path Detail Pages”, simply dictating the 
total duration of each path and the number of tasks within it as seen below. 
 

• Display Path Detail Pages 
o To create a text result file for each path of the critical path, check this box. Up to five 

files will be generated (one for each sub-path). Each of these will dictate the tasks within 
a path, their duration, and other notable details about them. It is similar to the “Master 
Descriptions Page”, but instead of detailing the entire critical path and its sub-paths, it 
will be focused on each sub-path and the tasks within it. 

o When using this option, up to 2 additional columns may be shown on the Path Detail 
pages. You may specify these fields and what their column headers will be in the 
additional options that appear when this box is checked. 

 

• Auto Size Chart Height 
o Checking this option will cause the tool to increase the chart’s height based upon 

the number of rows required for the critical path to be shown; specifically, every 
row over 60 will grow the default chart height by an additional 0.16 inches. Note 
that it will most likely render the chart unable to be printed as the default template 
height is already set to standard paper dimensions (8” x 11”). If the charts need to 
be printed, try using the Default Lines per Page setting instead. 

  



 
Operational Decision Software & Services 

Page 14 of 32 
 

700 Boulevard South  Suite 406  Huntsville, AL  35802  Tel: (256) 881-1038  Fax: (256) 881-4791  www.opdec.com 

Critical Path Lists 
The tool provides the user with the ability to run many critical paths with one button click. This 
reduces the manual effort required to run critical path charts for every desired task within a 
schedule. To get started, select the “Tools” menu option, and then select “Manage Lists”. 
 
 

Multiple Lists 
The List Management area allows you to create multiple lists 
of tasks to run critical paths to. Each list must correspond to 
a settings profile. What settings profile used can be changed 
through the “Profile” dropdown located near the top of the 
form. The “File” menu option can be used to create new lists 
and rename, save, or delete the currently selected list. 
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Creating a List 
 

 
 

• List Type 
o Filter 

▪ If the “Filter” option is selected, the list type will use a Project filter that the 
user has already created. The Filter dropdown below will become enabled, 
and within it will be displayed all filters known to the active schedule. In this 
way, for instance, a user could create a Project filter called “Major Events” 
with a criteria to filter down the schedule to only display tasks with a Major 
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Event value assigned (as identified in the Critical Path Settings). The tool will 
run a critical path to every task meeting the criteria specified in the given 
task filter. 
 

o Unique ID 
▪ If the “Unique ID” option is selected, the list will contain the manually 

entered Unique IDs from the “Unique IDs” area below. The user may enter 
as many as desired using the textbox provided, and either pressing the Enter 
key or clicking the “Add” button. If a Unique ID needs to be removed, you 
may select the desired row and click “Remove Selected”. Likewise, the 
“Remove All” button will clear the list, and the user may start again. 

• Note: If a Unique ID is not found within the active schedule, the 
“Unique IDs” area will not be able to display its Task Name or ID. 
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Chart Creation 
 

 
 

1) Select the Settings profile applicable to the current schedule. 
 

2) Enter the critical path you would like to create a chart for. If creating a single chart, use the 
Event Field and Event options. If creating multiple charts, select which Critical Path List to 
use. Select the “Not Applicable” list to use the Event Field and Event options; only one may 
be used at a time, so if a list is selected, the Event Field and Event options are disabled. 
 

a. Critical Path lists come from the List Management form. Please see the above 
section, Creating a List, for more information. 

b. To create a single critical path chart, enter the field that contains the event you are 
going to measure. Options are Unique ID, ID, or the Settings Default which would be 
the “Major Event” field specified in the settings. Next, enter the event in which to 
measure (Unique ID, ID, or the text/number values contained within the Major 
Event field). 

 
3) Select the number of paths to display 

 
4) Identify the template to use in creating the critical path chart. Typically, the default 

“CriticalPath” template will be used. However, if only a Master Detail or Path Detail chart is 
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required, you may select the “CriticalPathDesc” or “CriticalPathItemDesc” templates 
respectively. Also, any custom templates made by the user will be displayed here (provided 
they are placed within the “Milestone Template Location” folder specified to the selected 
settings profile). 

 
5) Click the Run button. The status bar at the bottom of the form will update the user on the 

tool’s progress, and the resulting chart will be displayed (if a single chart is run). If multiple 
charts are processed using a critical path list, then Milestones Professional will close after 
finishing, and the user must navigate to their “Result Save Location” folder to find the 
produced files. 

 
6) Hyperlinks can be selected from each symbol to show further detail for that path if the 

path detail files were created (as set in your Settings Profile). The selection of the target 
event hyperlink will bring you to a page detailing the top path issues. 
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Export Milestone Professional files 
 

 
 
The tool provides a utility to export Milestones Professional images to a Microsoft PowerPoint 
presentation. Each file selected will be placed on slide in the resulting presentation. To get started, 
click on the “Tools” menu item and then click on the “Export to PPT” menu item.   
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• Directory – The text field at the top of the form tells the utility where to find Milestone 
Professional files. This field is defaulted to the save directory specified in the Critical Path 
settings dialog. The browse button will allow you to select a different directory. 
 

• Search Subdirectories – This option lets the “Find Now” action know whether to only search 
files within the immediate folder location specified, or whether it should search all subfolders 
within the directory. 

 

• Find Now – This button searches the directory (and if specified, its subdirectories) for all 
Milestones Professional files. Each file found will be loaded as a checked item in the file display 
grid below it. 

 

• File Display – This list displays all files found by the search. Each file can be checked/unchecked 
to indicate whether it should be exported to PowerPoint. 

 

• Show/Hide Custom Settings – This menu option will expand the export utility interface to 
include the Custom Settings area at the bottom of the interface. These settings will dictate the 
size and position of the image in PowerPoint. 

o The Keyword column contains fields where the user may enter any unique word or 
phrase that will be in the Milestones Professional files' name. Any file name that 
contains the keyword entered will have the corresponding size and position settings 
applied to it when the image is exported to PowerPoint. 

o The Horizontal column should contain how many inches from the left you would like 
your image placed on the PowerPoint slide. This field should correspond to the 
"Horizontal" field in the "Size and Position" window of the image in PowerPoint. 

o The Vertical column should contain how many inches from the top you would like your 
image placed on the PowerPoint slide. This field should correspond to the "Vertical" 
field in the "Size and Position" window of the image in PowerPoint. 

o The Height column should contain the desired height in inches you would like your 
image to be once the image has been placed in PowerPoint. This field should 
correspond to the "Height" field in the "Size and Position" window of the image in 
PowerPoint. 

o The Width column should contain the desired width in inches you would like your 
image to be once the image has been placed in PowerPoint. This field should 
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correspond to the "Width" field in the "Size and Position" window of the image in 
PowerPoint. 

 

• Export to PPT – This button will create MS Power Point slides for each file in the file listing.  
Each page of a Milestone Professional file will become a single MS Power Point slide. The 
generated PowerPoint is not saved, but left open and displayed to the user.  
 

• Force (4:3) Aspect Ratio – This checkbox will configure the resulting PowerPoint into a 
standard (4:3) resolution (intended for standard monitors, not widescreen ones). If your 
images look stretched or with extra room on the slide, try setting this option to improve the 
results. 

 

• Resize Images to Fit Slide – This option will force the chart image inserted into the PowerPoint 
to cover the entire slide it’s put on. This may be helpful especially in conjunction with charts 
produced using the “Auto Size Chart Height” setting, as these larger images can extend beyond 
the slide’s width/height. This option can either shrink or grow the image, and does not regard 
the original aspect ratio of the image. 
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Utilizing Milestone Professional Templates 
The Critial Path Tool display’s data from MS Project by utilizing Milestones Professional templates. 
While a default chart template is provided with the tool, it can be configured to display and report 
various types of information. Some of the more common attributes that are manipulated via the 
template are as follows: 

• Text sizes and placement 

• Graphical indicators 

• Symbol manipulation (for Gantt charts) 

• Introduction of company and/or program logos 

• Legend entries 

• Row shading 

• Much, Much, More 
 
To learn more about utilizing Milestone Professional templates, contact KIDASA software @ 1-800-
765-0167 or OPDEC support @ 256-881-1038  
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Column Properties 
To change the data being populated into a templates’ column, double-click the column’s header and 
then the Column Formatting tab (Figure 10). The automation tag is used by the Critcial Path Tool to 
determine the type of MS Project data 
that should be populated into it.  This tag 
can be automatically populated by 
selecting the ‘MS Project field’ 
dropdown and selecting the field you 
would like to display. Doing this will 
automatically populate the automation 
tag with the approriate value. In this 
example, the ‘Baseline Start’ date was 
selected. Notice that the automation tag 
shows’baselinestart’. This is exactly how 
the field values needs to be displayed in 
order for it to be picked up by the tool. 
 
Symbols and Connectors 
Connectors and symbols (Figure 11) can 
be modified within the Milestones 
Professional personal template. The default 
template is named “CriticalPath.MTP” and 
located in your installation directory (default is C:\Program Files\OPDEC 
Tools\Critical Path). 
 
1) The horizontal symbols and task connectors for activities can be changed by 

modifying rows 1-5 from the toolbar 
2) The milestone symbols that are used within the 5 paths can be changed by 

modifying rows 6-10 
a. The status symbol is found on row 8 column 4 
b. The target finish milestone symbol is found on row 9 column 2 
c. The forecast finish milestone symbol is found on row 9 column 4 
d. The contract milestone symbol is found on row 10 column 2 

3) The horizontal connector between the target finish and the forecast finish is 
found at row 9 column 3 

4) The vertical connections between the paths can be change by modifying row 
17 and row 18 at column 1. 

 
Note: Symbols can also be manipulated to display values being populated within 
the columns of the chart (regardless if they visible or hidden). 

Figure 11 

Figure 10 
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Check Schedule 
The Critical Path 2020 tool comes with a utility that will check your schedule file for potential 
problems that may obstruct the true Critical Path from revealing itself. To use this utility, click on 
the "Tools" menu item, and select "Check Schedule" from the list to display the Check Schedule 
user interface. 
 
The checklist that the utility goes through will first appear grayed out. Once the "Run" button is 
clicked, the utility will enable the items in the list as the utility checks them, turning the text black. 
The number to the left of each list item references how many issues were found. Optimally, all of 
these items will have a "0" next to them to indicate that no issues were detected. 
 

 
 

• Summaries with Pred/Succ - Indicates the number of summary tasks with a predecessor or 
successor. 

• Multiple Task Calendars - Indicates the number of task calendars currently utilized. View 
the "task calendar" field for more information. 

• Elapsed Durations/Leads/Lags - Indicates the number of activities that are using elapsed 
days/weeks/minutes/etc in the duration field or in leads/lags. 

• Sub Projects Inserted - Indicates the number of sub projects contained within your 
schedule. 

• External Links - Indicates the number of external links utilized in the schedule. 
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Common Errors 
 

1. MSID Not Found in the First Path – This error means that the task you are measuring a 
critical path to (the MSID or “Milestone ID”) was not found in the first path. Your target 
task must be in the first path in order for the tool to perform its calculations. 
Unfortunately, this error has no clear resolution. To diagnose the cause, please see the 
Manual Critical Path Steps at the bottom of this section. When you constrain the target 
task to twenty years prior to its target date, it should have the same total slack value as the 
rest of the tasks in its first path. 
 

2. Unable to determine the connection type for [Task ID] – This error is usually caused by 
either subprojects or external links within the schedule. The tool is unable to connect to 
those external files, and the predecessor/successors relationships cannot be determined 
properly. Other Project features that interfere with Total Slack calculations like hard 
constraints or levelled resources can also drive this error. The tool will assume a Finish-to-
Start relationship by default, but there may be errors in the resulting chart. You can use the 
Check Schedule feature to find how many subprojects/external links are present to resolve 
the issue; the only way to do so is to merge the schedules into a single file. 
 

3. Unable to determine Path # connection with previous paths – This error is typically caused 
by constraints or deadlines along one path that prevent its total slack from aligning with 
other paths. To investigate, follow the manual critical path steps until Step #3. When 
identifying individual paths based on negative Total Slack, check the Constraint Type, 
Constraint Date, and Deadline columns. If there are any present along the path on tasks 
that are NOT identified as Major Events, it could be skewing calculations and obscuring the 
path connections. Try removing the deadlines or setting the Constraint Type to “As Soon As 
Possible” to produce a more accurate chart. 
 

4. Error: ‘462-Remote server machine does not exists’ or ‘462-RPC does not exist’ – This error 
is typically caused by the tool losing its connection to Milestones Professional. Enabling the 
“Run as Multiple Instances for COM/Automation” setting within Milestones Professional 
may resolve the problem. A detailed explanation of this setting can be found in the 
Milestones Professional Setup section of this document. 
 

5. Cannot remove constraints/deadlines on major event tasks that are manually scheduled – 
This error means that the tool found tasks in your schedule that were labelled as major 
events (as per the field identified in your settings profile) but were also marked as being 
Manually Scheduled. One of the first steps the tool takes is to release all major events in 
the schedule; this means that all constraint types are set to “As Soon As Possible” and all 
deadlines are set to “NA”. With manually scheduled tasks, Project disables these options, 
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and the tool cannot set any values without encountering errors. The solution to this 
problem is to either set these tasks back to being Auto Scheduled, or to stop identifying 
these manually scheduled tasks as major events (set to blank if Text field or set to 0 if 
Number field). Please see the image below for an example of this task option. 
 

 
 

6. Error: 429-Cannot Create ActiveX Component – This error usually indicates the tool is 
having difficulty automating Milestones Professional, which is the application our tool 
interfaces with to generate the critical path chart. You may be able to resolve the problem 
by following the steps detailed in the Milestones Professional Setup section of this 
document. 
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Manual Critical Path Steps 
 
Below are the manual steps you can take to calculate the same critical path as the tool. 
Following these can be helpful in diagnosing problems when running a particular critical path 
and can highlight variances between the critical path chart and the schedule. Please see below 
for the full step-by-step guide. 

 
1. Release (remove any constraints or deadlines) all major events (the field is identified in 

your settings) 
2. Constrain the event that’s being measured with a “Finish No Later Than” type, and set it to 

Finish No Later Than the Target Date minus 20 years. 
3. Sort your schedule on total slack and identify the paths by float value (the first path will be 

the smallest series of unique total slack values). 
a. At this point, your schedule should look something the image below. The 

identification (“This is Path #”) is being made in a custom text field by looking at the 
different sets of Total Slack values. 
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4. Change the constraint date on the event being measured to the target date. Leave the 

Constraint Type as “Finish No Later Than”. 
5. Filter down the visible tasks to only show those identified as part of a path (in Step 3). 
6. Sort the following fields in the following order: path identification field (Empty Text Field in 

your Settings), Finish, Start 
7. Re-evaluate each paths’ logic to check for multiple paths within each unique float value 
8. Restore major event constraints 
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Frequently Asked Questions 
 
In this area, we will address some common questions and problems when running the Critical Path 
tool. 
 
 

1. Does the Critical Path tool work with schedules with multiple calendars? 
 
No. The tool calculates the critical path based purely on task duration and total slack. 
Utilizing two different calendars (e.g. a five-day work week and a seven-day work 
week) within the same path results in inaccuracies in the Total Slack, and the tool will 
not be able to properly distinguish individual paths. The calendars must be normalized, 
and start/finish dates and durations adjusted accordingly in order to be compatible 
with the tool. 
 

2. Does the Critical Path tool work with lower level schedules that flow up into a master 
schedule via subprojects/external links? 

 
No. The tool is unable to determine connections between tasks across multiple Project 
files. The connection type (e.g. Finish-to-Start, Finish-to-Finish) between successors 
and predecessors is unclear, and the total slack calculations within Project are also 
inaccurate. The tool will typically either give errors or produce inaccurate results. 
 

3. My critical path has a long sequence of tasks, and the resulting chart has overlapping 
task names. Can I extend the chart to make the task names readable? 
 

Yes. There are three ways to do this. By default, the tool will utilize as many rows as 
needed to complete the chart, but the template is sized to be printable. Sometimes 
this results in the text of the task names overlapping rendering it unreadable. There 
are a couple ways to fix this issue. 

 
i. Use the “Default Lines per Page” option in the Critical Path Settings. Setting this 

value in your settings will cause the chart to be created on multiple pages. For 
instance, if your compressed, unreadable chart has 90 rows on one page in 
Milestones Professional, setting this option to 30 will cause the chart to flow onto 
three separate, readable pages. 
 

ii. Use the “Auto Size Chart Height” checkbox in your Settings profile. This option will 
attempt to adjust the chart’s vertical height to give the chart enough room to be 
visible. The “Defaults Line per Page” option will allow the user to spread the chart 
over multiple, printable sheets, while this option will extend the chart vertically 
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without regard to its printability. Specifically, for every row over 60 rows in the 
chart, the vertical height will be extended by 0.16 inches. This allows the text to 
not overlap, but you may get a resulting chart that is very long. 
 

iii. Change the resulting chart’s height and width manually. The default size of the 
template is 8.5 x 11, and increasing those values in Milestones Professional will 
cause the chart to increase in size and therefore making the text readable. The 
chart will be on one page, but may not be printable. 

 
4. Can I export my Settings Profiles to another user or another PC? 

 
Yes. The settings profiles are stored within the registry, and these registry entries can 
be exported and loaded as desired. Please see below for a step-by-step on the 
process. 

 
i. Open Registry Editor by typing “regedit” into Windows search (be sure to “Run As 

Administrator” from the right-click menu) 
ii. Navigate to the registry directory below 

1. Computer\HKEY_CURRENT_USER\Software\OPDEC 
iii. Export the entire OPDEC folder 

1. Select the key (it looks like a folder in the Registry Editor) 
2. Right-click, and select “Export” 
3. A file (*.reg) will be created. Use the prompt to choose a save location of your 

preference. 
iv. Place the generated registry file onto the PC you wish to have the settings profiles 

and double-click it. The file will load those settings into the current user’s registry, 
and they will appear upon next launch of the tool. 

 
5. Can I export my Critical Path Lists to another user or another PC? 

Yes. The Critical Path Lists can be found in the directory below by default (subject to 
change depending on root drive and Windows user name). Simply copy/paste the text 
files found within into the same directory on the target PC. Note that the “AppData” 
folder may be hidden; if you cannot see this folder, click on the “View” tab of File 
Explorer and check the “Hidden Items” textbox in the “Show/hide” group. 
 
i. C:\Users\[Your Username]\AppData\Local\OPDEC Tools\CP Lists 
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Revision History 
 

• V20.0.0 (02/07/2020) 
o Initial release of the 2020 version of the Critical Path Tool. 

• V20.1.0 (03/24/2020) 
o Resolved issues with form visibility on low resolution monitors and PCs utilizing 

Windows 7 zoom features. 

• V20.2.1 (05/11/2020) 
o Updated to allow for activation on FIPS-compliant systems. 

• V20.2.2 (01/26/2021) 
o Important update to resolve issue of the add-in failing to load into the Microsoft 

Project ribbon. 

• V20.2.3 (07/01/2022) 
o Update to resolve issue with users installing the application without .NET 

Framework 3.5. 

• V20.2.4 (04/07/2023) 
o Fixed a bug with the External Links check in the Check Schedule causing normal 

tasks to be flagged as externally linked in some configurations of Microsoft Project. 
o Fixed a bug causing tasks to be displayed with hashed lines if the user utilized the 

“Append Onto Activity” setting. Tasks will now never be shown in this hashed-line 
format. 

o Fixed a bug causing the offline help documentation to not be launched from the 
Help menu. 

o Improved the tool’s ability to handle an unexpected error while running multiple 
charts in a Critical Path List. 

• V20.2.5 (5/25/2023) 
o Fixed a bug where “SF” (Start-To-Finish) logical links were not recognized, causing 

the tool to error on paths where they exist. 
o Improved “MSID Not Found in the First Path” error messaging. 

• V20.2.6 (10/13/2023) 
o Added additional information on Common Error #6 to the tool and guidance for its 

resolution to this help doc. 
o Resolved error resulting from clicking the Run button multiple times. 


	Minimum Software Requirements:
	Installation and Activation
	Milestones Professional Setup
	Configuring the Critical Path Settings
	Settings Profile
	Required Settings
	Optional Settings

	Critical Path Lists
	Multiple Lists
	Creating a List

	Chart Creation
	Export Milestone Professional files
	Utilizing Milestone Professional Templates
	Column Properties
	Symbols and Connectors

	Check Schedule
	Common Errors
	Manual Critical Path Steps

	Frequently Asked Questions
	Revision History

